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Abstract ² University leaders have the responsibility to 

monitor all activities and make continuous measurements on 

the performance and quality of higher education which leads 

to ensure the achievement of the goals set. All this to get some 

of the information required, University leaders still have to do 

the data collection scattered information systems, either 

manually. It can slow down the decision making process for 

people who are at the manager level and above so they can¶W 

monitor the performance and quality of higher Education any 

time. 

Making college visualization of data information by using data 

warehouse and dashboard of the system can help university 

leaders in monitoring the performance of all units in college he 

leads. The system also performs measurements continuously on 

the performance and quality of higher education lead. 

 
Keywords: dashboard system, data warehouse, performance, 

Visualization of information 

I. PENDAHULUAN 

Pimpinan perguruan tinggi memiliki tanggung jawab 

untuk melakukan monitoring perkuliahan, keuangan, point 

keaktifan mahasiswa dan kinerja dosen dan sebagainya  

serta melakukan pengukuran secara terus menerus terhadap 

kinerja dan kualitas perguruan tinggi yang dipimpinnya 

untuk memastikan ketercapaian tujuan yang telah ditetapkan. 

Untuk itu dibutuhkan sebuah sistem informasi yang 

terintegrasi dengan baik. Sistem informasi dapat digunakan 

untuk mendapatkan data, mengolah data menjadi informasi 

dan menyebar informasi hasil pengolahan data yang 

sebelumnya untuk menunjang kegiatan operasional sehari-

hari sekaligus menunjang kegiatan pengambilan keputusan 

yang strategis. Hambatan yang sering ditemui adalah 

kenyataan bahwa sistem informasi yang ada belum 

terintegrasi secara sempurna dan mengakibatkan informasi 

yang tersaji kurang lengkap dan akurat[11]. 

Selama ini untuk mendapatkan beberapa informasi yang 

dibutuhkan mengenai performa perguruan tinggi, pimpinan 

perguruan tinggi masih harus melakukan pengumpulan data 

yang tersebar di beberapa sistem informasi, baik dengan 

cara melakukannya sendiri atau masih harus memintanya 

terlebih dahulu ke bagian terkait dan kemudian melakukan 

analisa sendiri data-data tersebut ataupun secara manual, 

Hal tersebut dapat memperlambat dalam proses 

pengambilan keputusan karena orang-orang yang berada di 

level manajer keatas tidak dapat memonitor performa dan 

kualitas perguruan tinggi setiap saat.  

Pembuatan visualisasi Informasi  data perguruan tinggi 

dengan menggunakan data warehouse dan dashboard 

sistem ini dapat membantu pimpinan perguruan tinggi dalam 

memantau atau memonitor performa semua unit di  

perguruan tinggi yang dipimpinnya diantaranya melakukan 

monitoring perkuliahan, monitoring keuangan, monitoring 

point keaktifan mahasiswa dan monitoring kinerja dosen 

dan melakukan pengukuran secara terus menerus terhadap 

kinerja dan kualitas perguruan tinggi yang dipimpinnya.  

Data warehouse didefenisikan sebagai koleksi data yang 

bisa digunakan untuk menunjang pengambilan keputusan 

manajemen yang berorinetasi pada topik (subject), terpadu, 

time variant, dan tidak mudah berubah[6]. Sedangkan 

Dashboard system adalah sebuah tampilan pada satu 

monitor komputer, yang berisi informasi yang bersifat  kritis, 

agar dapat dilihat dengan segera, sehingga dengan melihat 

dashboard itu saja,  dapat diketahui hal-hal yang perlu 

diketahui. Biasanya kombinasi dari teks dan grafik, tetapi 

lebih ditekankan pada grafik [1]. Dashboard  juga 

mengandung key performa indicator yang membuat user 

dapat mengetahui kondisi dari data-data perguruan tinggi  

yang ada saat ini dalam keadaan bagus, normal atau buruk. 

Penelitian dilakukan dengan cara  mengekstrak informasi 

penting  dari data yang tersebar  di beberapa sistem 

Informasi perguruan tinggi dengan menggunakan data 

warehouse, data yang sudah terintegrasi  selanjutnya dapat 

dimanfaatkan untuk kegiatan penyampaian  visualisasi 

informasi dalam bentuk teks dan grafis yang dapat 

memberikan kemudahan dan juga dilengkapi dengan key 

VISUALISASI INFORMASI DATA 

PERGURUAN TINGGI DENGAN DATA 

WAREHOUSE DAN DASHBOARD SYSTEM   
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performance indicator (KPI). Penelitian ini diharapkan 

bermanfaat bagi institusi juga sebagai pedoman  untuk 

pengelolaan manajemen  institusi pendidikan tinggi pada 

semua jenjang atau tingkatan  

 

1.1. Tinjauan Pustaka 

1.1.1. Informasi 

Sistem informasi mencakup sejumlah komponen 

( manusia, Komputer, teknologi informasi dan prosedur 

kerja) ada sesuatu yang diproses (data menjadi informasi) 

dan dimaksudkan untuk mencapai suatu sasaran atau tujuan 

[2]. 

 

1.1.2. Visualisasi Data atau Informasi 

Tujuan utama dari visualisasi data adalah untuk 

mengkomunikasikan informasi secara jelas dan efektif 

dengan cara grafis [3]. Bukan berarti visualisasi data harus 

terlihat membosankan supaya berfungsi atau sangat canggih 

supaya terlihat menarik. Untuk memaparkan ide secara 

efektif, bentuk estetis dan fungsionalitas harus berbarengan, 

menyediakan wawasan bagi kumpulan data yang kompleks 

dan jarang dengan mengkomunikasikan aspek-aspek kunci 

dengan cara yang intuitif. Namun perancang terkadang 

gagal mencapai keseimbangan antara bentuk dan fungsi, 

menciptakan visualisasi data yang menawan yang gagal 

menyediakan tujuan utamanya. 

Jadi, Visualisasi data atau Informasi adalah suatu metode 

penggunaan komputer untuk menemukan metode terbaik 

dalam menampilkan data untuk mengingat informasi dengan 

cara penerimaan alami manusia serta memberikan cara 

untuk melihat data yang sulit dilihat dengan pemikiran 

sehingga peneliti bisa mengamati simulasi dan komputasi, 

juga memperkaya proses penemuan ilmiah dan 

mengembangkan pemahaman yang lebih dalam dan tak 

diduga, contoh, struktur tree dan grafik 

 

1.1.3. Dashboard System 

Dashboard adalah sebuah tampilan visual dari informasi 

terpenting yang dibutuhkan untuk mencapai satu atau lebih 

tujuan, digabungkan dan diatur pada sebuah layar, menjadi 

informasi yang dibutuhkan dan dapat dilihat secara sekilas. 

Tampilan visual disini mengandung pengertian bahwa 

penyajian informasi harus dirancang sebaik mungkin, 

sehingga mata manusia dapat menangkap informasi secara 

cepat dan otak manusia dapat memahami maknanya secara 

benar.[8] 

Dashboard itu sebuah tampilan pada satu monitor 

komputer penuh, yang berisi informasi yang  bersifat kritis, 

agar kita dapat melihatnya dengan segera, sehingga dengan 

melihat dashboard itu saja, kita dapat mengetahui hal-hal 

yang perlu diketahui. Biasanya kombinasi dari teks dan 

grafik, tetapi lebih ditekankan pada grafik. [1] 

 

1.1.4. Key  Performance Indicator (KPI) 

 KPI adalah indikator yang merepresentasikan kinerja 

dari proses yang dilaksanakan. Key Performance 

Indicator(KPI) merupakan sekumpulan ukuran mengenai 

aspek kinerja yang paling kritis, yang menentukan 

kesuksesan organisasi pada masa sekarang dan masa yang 

akan datang [4]. KPI digunakan memprediksi peluang 

kesuksesan atau kegagalan dari proses-proses yang 

dilaksanakan organisasi, sehingga KPI dapat digunakan 

sebagai alat untuk meningkatkan kinerja organisasi secara 

dramatis. Contoh dari penjelasan diatas adalah penentuan 

parameter nilai dalam trend penerimaan mahasiswa baru 

membuat user dapat dengan mudah mengetahui kondisi 

penerimaan mahasiswa baru apakah sedang bagus atau tidak. 

 

1.1.5. Grafik 

Ada beberapa tipe grafik atau diagram yang dapat 

digunakan untuk menampilkan gambaran informasi supaya 

lebih jelas, antara lain: 

a. Diagram garis. Diagram garis digunakan untuk 

menunjukan perubahan nilai dari sederetan data 

relatif terhadap waktu, karena diagram garis 

biasanya digunakan untuk menunjukkan suatau 

kecenderungan atau trend. 

b. Diagram batang. Diagram batang digunakan 

untuk menyajikan nilai relatif terhadap data 

yang lain. Misal, eksekutif ingin melihat grafik 

pendaftar per-tahun dan per-gelombang. 

c. Diagram roti (pie). Diagram pie biasanya 

digunakan untuk menggambarkan besarnya 

prosentase data. Misalkan menggambarkan 

besarnya prosentase alasan mahasiswa keluar. 

Grafik merupakan penggambaran data - data yang diplot 

dalam sebuah bidang yang menghubungkan dua variabel 

atau lebih [5]. 

 

1.1.6. Data Warehouse 

Data warehouse ialah sekumpulan informasi yang 

disimpan dalam basis data yang digunakan untuk 

mendukung pengambilan keputusan dalam sebuah 

organisasi. Data dikumpulkan dari berbagai aplikasi yang 

telah ada. Data yang telah dikumpulkan tersebut kemudian 

divalidasi dan direstrukturisasi lagi, untuk selanjutnya 

disimpan dalam data warehouse. [9] 

Data Warehouse adalah kumpulan dari informasi yang 

sama baiknya seperti sistem pendukung keputusan. Data 

Warehouse mempunyai perbedaan karakteristik utama yang 

lebih ditekankan untuk DSOLNDVL� SHQGXNXQJ� NHSXWXVDQ´��

Dengan definisi ini Data Warehouse dipandang memiliki 

karateristik yang berbeda  dari sistem pendukung 

operasional lainnya. Secara khususnya karena ditujukan 

sebagai aplikasi pendukung pengambilan keputusan.[10] 

 

1.1.7. Online Transaction Processing (OLTP) 

OLTP adalah singkatan dari OnLine Transaction 

Processing. Kata Online ini redundan dalam banyak kasus 

sekarang ini karena hampir semua transaksi dapat dilakukan 

secara online. Dalam kenyataannya, masih ada transaksi-

transaksi yang tidak benar-benar online. Bila melakukan 
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transaksi keuangan antar bank, masih ada proses-proses 

yang menunggu kliring keesokan hari. ini adalah contoh 

transaksi yang tidak online [7]. Pada literatur-literatur 

pemrograman dekade 1980 transaksi online mungkin dapat 

disebut sebagai pemrosesan yang interaktif atau waktu-

nyata (real time). Di sisi lain, transaksi 'offline' (seperti yang 

memerlukan kliring keesokan hari pada contoh diatas ) 

disebut sebagai pemrosesan yang batch. 

 

1.1.8. Online Analytical Processing (OLAP) 

OLAP (On-Line Analytical Processing) adalah suatu 

pernyataan yang bertolak belakang atau kontras dengan 

OLTP (On-Line Transaction Processing). istilah OLAP 

muncul pertama kali pada tahun 1993 yang diperkenalkan 

oleh Edgar F. Codd, S. B. Codd, dan C. T. Salley dalam 

GRNXPHQ� XQWXN�$UERU�EHUMXGXO� ³Providing OLAP to User-

Analysts: An IT Mandate´��2/$3�PHQJJDPEDUNDQ� VHEXDK�

klas teknologi yang dirancang untuk analisa dan akses data 

secara khusus. Apalabila pada proses transaksi pada 

umumnya semata-mata adalah pada relational database, 

OLAP muncul dengan sebuah cara pandang multidimensi 

data.  Cara pandang multimensi ini didukung oleh tehnologi 

multidimensi database. Cara ini memberikan tehnik dasar 

untuk kalkulasi dan analisa oleh sebuah aplikasi bisnis [7]. 

 

1.2.Tujuan dan Manfaat  

1.2.1.Tujuan 

Tujuan dari penelitian ini adalah merancang dan 

membangun sebuah aplikasi visualisasi Informasi data 

perguruan tinggi dengan menggunakan data warehouse dan  

dashboard system yang bisa mengelola data berdasarkan 

kelompok dan historinya serta  menampilkan  informasi 

yang dibutuhkan oleh pihak pimpinan perguruan tinggi 

dalam melihat performa dan mengukur kinerja perguruan 

tinggi yang dipimpinnya sehingga pimpinan perguruaan 

tinggi tidak akan mengalami kesulitan dalam mengambil 

keputusan dengan cepat dan tepat karena didukung oleh 

pengolahan data dan visualisasi yang mudah dilihat dan 

dipahami. 

 

1.2.2.Manfaat 

Keutamaan dari penelitian ini adalah pada implementasi 

data warehouse dalam mengelompokkan data-data 

akademik maupun non akademik yang terdiri dari beberapa 

format dan tipe data yang berbeda-beda serta tersebar di di 

beberapa sistem informasi yang ada berdasarkan kebutuhan 

penggunanya dan historinya sehingga tidak akan 

mengganggu kinerja data-data operasional. Penggunaan 

Dashboard System akan memberikan kemudahan bagi 

pimpinan perguruan tinggi dalam melihat laporan yang 

disajikan karena berbeda dengan laporan yang biasanya di 

tampilkan dalam bentuk tabel-tabel, karena  data akan 

ditampilkan dalam bentuk dashboard yaitu kombinasi 

antara teks dan grafis yang mengandung key performance 

indicator (KPI) dan dapat dipergunakan sebagai pendukung 

pengambilan keputusan. 

 

II. METODE PENELITIAN 

2.1.Bagan alir penelitian 

Bagan alir penelitian ini dapat di lihat pada gambar 1 

dibawah ini : 

 
Gambar 1. Bagan Alir penelitian 

 

2.2. Langkah-Langkah Penelitian 

Berikut ini merupakan rincian mengenai setiap langkah 

dari sistematika model metodologi pemecahan masalah 

yang digunakan dalam penelitian [7]. 

a. Penelitian Pendahuluan 

Tahap ini merupakan langkah awal penelitian yang 

dilakukan dimana penelitian pendahuluan dimaksudkan 

untuk memahami proses yang ada.. Penelitian dilakukan 

dengan melakukan observasi secara langsung mengenai 

aktivitas- aktivitas yang terjadi pada pihak-pihak terkait. 

b. Identifikasi dan Perumusan Masalah 

Setelah penelitian pendahuluan dilakukan melalui 

pengamatan langsung di lapangan dan wawancara dengan 

pihak terkait, maka dapat diketahui permasalahan-

permasalahan apa saja yang dihadapi. Masalah yang 

ditemukan kemudian akan dianalisa dan dirumuskan 

penyebab serta solusi yang memungkinkan untuk 

dikembangkan. 

c. Studi Pustaka 

Studi pustaka dilakukan untuk menambah wawasan dan 

pengetahuan mengenai permasalahan yang akan dibahas dan 

menentukan metode yang cocok untuk memecahkan 
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masalah yang sedang dihadapi. Studi pustaka dapat 

ditelusuri melalui literatur berupa buku panduan, jurnal, 

hasil penelitian orang lain berupa tesis dan skripsi, serta 

pencarian informasi melalui internet. 

d. Analisis Sistem Informasi dan Proses Bisnis 

Tahap selanjutnya adalah melakukan analisis terhadap 

semua permasalahan dan proses Bisnis yang ada. Analisa 

bertujuan untuk menganalisa sistem yang saat ini sedang 

berjalan, kemudian memberikan usulan perbaikan sistem 

berdasarkan kebutuhan. 

e. Perancangan Data Warehouse dan Dashboard  

Pada tahap ini dirancang data warehouse dan dashboard 

system yang sesuai dengan kegunaan. Perancangan dan 

Pembuatan Sql Server dan Visual Studio. 

f. Pengujian Data ware house dan Pembuatan 

Dashboard System 

Pengujian yang dimaksud disini untuk mengetahui 

apakah Data ware house dan Dashboard System yang telah 

dibuat telah memenuhi user requirements yang telah 

ditentukan pada awal proses analisa sistem. Jika ternyata 

Data ware house dan Dashboard System tersebut tidak dapat 

memenuhi kebutuhan penggunanya, maka harus dilakukan 

analisa ulang. 

g. Kesimpulan dan Saran 

Berisi kesimpulan yang dapat ditarik dari penelitian dan 

analisa yang telah dilakukan.  Bagian ini juga memuat saran  

yang  diperuntukkan  bagi  pihak perguruan tinggi, serta 

pihak-pihak lainnya yang dapat memetik manfaat dari hasil 

penelitian, dan juga bagi peneliti-peneliti berikutnya. 

 

III. HASIL DAN PEMBAHASAN 

3.1.Tahap Perancangan Data Warehouse 

Proses perancangan data warehouse yang dilakukan 

menggunakan metode bottom-up. Hal ini dilakukan karena 

perancangan data warehouse ini bersumber dari 

permasalahan yang ada.. Perancangan data warehouse 

dilakukan secara bertahap per departemen dengan 

melakukan analisa secara mendetail terhadap departemen 

dengan acuan basis data Universitas. Setelah menganalisa 

kebutuhan yang ada maka telah berhasil di indentifikasi hal-

hal yang dibutuhkan untuk aplikasi yang akan 

dikembangkan. Sebagai uji coba dari data warehouse ini 

ditetapkan analisis-analisis yang akan 

dikembangkan.Setelah melakukan penyaringan terhadap 

semua data dan informasi telah dikumpulkan, maka akan 

dibuat tabel fakta dan tabel dimensi pada skema yang 

dibutuhkan dalam merancang data warehouse.  

Berikut beberapa perancangan data warehouse yang telah  

dibuat : 

 

a.Data warehouse perpustakaan  

 Perancangan data warehouse perpustkaan seperti 

terdapat pada gambar 2, sedangkan perancangan skema 

perpustakaan dapat dilihat pada gambar 3. 

 
Gambar 2. Perancangan Perpustakaan 

 

 

 

Gambar 3. Skema Perpustakaan 
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Skema Data warehouse untuk Perpustakaan dapat dilihat 

pada gambar 4 dibawah ini : 

 

 

Gambar 4. Skema Data warehouse 

 

Setelah Proses ETL sukses dijalankan langkah 

selanjutnya adalah membuat Cube. 

 

b.Data warehouse Akademik 

Proses ETL akademik tampak seperti gambar 5 dibawah 

ini. 

 

 
Gambar 5. Proses ETL Akademik 

 

c.Data Warehouse Penerimaan Mahasiswa Baru 

 Skema Penerimaan Mahasiswa Baru akan terlihat 

seperti gambar 6 dibawah ini. Sedangkan proses ETL dan 

Cube akan tampak seperti gambar 7 dan 8. 

 

 
Gambar 6 Skema Penerimaan Mahasiswa Baru 

 

 
Gambar 7. Proses ETL Mahasiswa Baru 

 

 
Gambar 8 Cube mahasiswa baru 
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d.Data WareHouse Alumni 

Skema database alumni, Proses ETL dan Cube terlihat 

dalam gambar 9,10 dan 11. 

 

 

Gambar 9. Skema Database Alumni  

 

 
Gambar 10. Proses ETL Data Alumni. 

 

 
Gambar 11. Cube Alumni 

e. Uji Coba Data warehouse 

Dari proses perancangan data warehouse , proses 

selanjutnya adalah melakukan ujicoba laporan yang diambil 

dari data-data yang ada di cube semua skema. Gambar 12 

sampai dengan gambar 19 adalah tampilan macam-macam 

laporan yang diambil dari perancangan data ware house. 

 
 

 

 

 

 

 

 
          

 

 

 

Gambar 12 Grafik penerimaan menurut kota asal 

 

 

 
Gambar 13. Grafik Lulusan mahasiswa 
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Gambar 14. Grafik IPK Rata-rata 

 
Gambar 15. Grafik mahasiswa Baru 

 

 

 
Gambar 16 Grafik Penerimaan Mahasiswa Baru Per Jurusan  

 

 

 
Gambar  17 Grafik Penerimaan Mahasiswa Baru berdasarkan Prodi  

 
Gambar 18: 3 besar kota yang dituju oleh alumni untuk bekerja setelah 

lulus  
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Gambar 19 Grafik data 3 besar kota persebaran alumni per program studi  

 

3.2.Tahap Pembuatan Dashboard System 

3.2.1. Identifikasi  Parameter Indikator 

Parameter indikator dapat membuat user dapat 

mengetahui kondisi informasi performa perguruan tinggi, 

apakah dalam keadaan bagus,  normal atau buruk. 

Berdasarkan hasil survey, tidak semua  informasi perguruan 

tinggi memiliki parameter indikator. Pada tabel 1 dibawah 

ini merupakan beberapa informasi-informasi perguruan 

tinggi yang memiliki nilai parameter indikator beserta nilai 

parameternya 

 

             TABEL 1.CONTOH INDIKATOR BESERTA NILAI PARAMETER 

No Informasi Parameter Status 

Batas 

Bawah 

 Batas 

Atas 

1 
Mahasiswa 

Baru 
Prosentase 

Buruk <0  15 

Normal 16  40 

Bagus 41  >100 

2 
Mahasiswa 

Registrasi 
Prosentase 

Buruk 0  69 

Normal 70  89 

Bagus 90  100 

3 

Mahasiswa 

Tidak 

Registrasi 

Prosentase 

Buruk 21  100 

Normal 11  20 

Bagus 0  10 

4 
Mahasiswa 

Cuti 
Prosentase 

Buruk 21  100 

Normal 11  20 

Bagus 0  10 

5 
Mahasiswa 

Keluar 
Prosentase 

Buruk 21  100 

Normal 11  20 

Bagus 0  10 

6 
Presensi 

Matakuliah 
Prosentase 

Buruk 15,1  100 

Normal 10,1  15 

Bagus 0  10 

7 
Kelulusan 

Mata kuliah 
Prosentase 

Buruk 0  80 

Normal 80,1  90 

Bagus 90,1  100 

8 

Rata-rata 

Pengerjaan 

TA 

Skalar 

Buruk 3,1  >4 

Normal 2,1  3 

Bagus 1  2 

9 
Rata-rata 

Lama Masa 
Skalar 

Buruk 5,1  7 

Normal 4,1  5 

Studi Bagus 3  4 

10 
Rata-rata 

IPK Lulusan 
Skalar 

Buruk <2,6  2,75 

Normal 2,75  2,9 

Bagus 2,91  4 

11 
Karyawan 

Cuti 
Skalar 

Buruk 11  20 

Normal 6  10 

Bagus 0  5 

12 
Absensi 

Karyawan 
Skalar 

Buruk 11  20 

Normal 6  10 

Bagus 0  5 

13 
Performa 

Dosen 
Skalar 

Buruk 0  2 

Normal 3  5 

Bagus 6  10 

14 
Karyawan 

Keluar 
Skalar 

Buruk 4  5 

Normal 2  3 

Bagus 0  1 

15 
Kehadiran 

Dosen 
Skalar 

Buruk 15,1  100 

Normal 10,1  15 

Bagus 0  10 

16 

Jumlah 

Koleksi 

Perpustakaan 

Skalar 

Buruk <5000  6000 

Normal 10000  20000 

Bagus 21000  30000 

     

 

 3.2.2. Pembuatan Dashboard 

Setelah indikator beserta nilai parameter ditentukan  

langkah selanjutnya adalah pembuatan  laporan dalam 

bentuk dashboard . Tampilan ini bertujuan mempermudah 

para manajer dalam pengambilan keputusan yang berkaitan 

dengan data-data perguruan tinggi dengan cara 

menampilkan informasi-informasi dalam sebuah dashboard 

system. Dashboard system yang dibuat menampilkan 

informasi-informasi dalam bentuk gauge bar dan chart. 

Berikut langkah-langkah menampilkan informasi dalam 

bentuk gauge bar menggunakan Visual Studio Business 

Intelligence seperti terlihat pada gambar 20 sampai dengan 

gambar 27 dibawah ini: 

 

Buka Visual Studio Business Intelligence > New > 

Project 

 

 
Gambar 20 Membuat project baru 
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Reporting Services > Report Server Project > Beri nama 

project > OK 

 

 
Gambar 21 Membuat report server project 

 

Klik kanan pada Shared Datasets > Add New Dataset 

 

 
Gambar 22 Membuat dataset 

 

Beri nama Dataset > New Data Source > Hubungkan 

dengan Data Source yang digunakan > Query sesuai 

kebutuhan > OK 

 

 
Gambar 23 Membuat datasource 

Reports > Add > New Item > Report Project > Report > 

Beri nama report> Add 

 

 
Gambar 24 Membuat report project 

 

 
Gambar 25 Membuat bar 

 

Pilih model dashboard yang digunakan untuk 

menampilkan informasi > OK 
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Gambar 26 Memilih model gauge bar 

Pilih dataset yang berisi informasi yang akan ditampilkan  

 

 
Gambar 27 Membuat koneksi antara gauge bar dan dataset 

 

Ubah parameter gauge bar sesuai dengan query 

 

3.2.3. Preview Dashboard 

Preview digunakan untuk menampilkan bar yang sudah 

dibuat. Berikut beberapa hasil Preview Seperti nampak pada 

gambar 28 sampai dengan gambar 31 dibawah ini. 

 

 
Gambar  28 Preview dashboard performa pegawai 

 
 

Gambar  29 Preview dashboard absensi pegawai 

 

 
 

Gambar   30 Preview dashboard Prestasi dosen dan staf 

 

 

Gambar  31 Preview dashboard performa perpustakaan 

 

IV. KESIMPULAN 

Dengan adanya satu aplikasi khusus di perguruan tinggi 

yang didukung oleh teknologi Data Warehouse dan 

Dashboard System yang dirancang dengan sedemikian rupa 

sehingga dapat mengelola dan menampilkan data-data yang 

sudah diolah dalam bentuk visualisasi informasi yang sangat  

dibutuhkan maka  pihak pimpinan perguruan tinggi dapat 

melihat performa dan mengukur kinerja perguruan tinggi 

yang dipimpinnya, dengan demikian pimpinan perguruaan 

tinggi tidak akan mengalami kesulitan di dalam 

pengambilan keputusan dengan cepat dan tepat karena 

didukung oleh pengolahan data dan visualisasi informasi 

yang mudah dibaca dan dipahami. Aplikasi ini masih 

membutuhkan perbaikan-perbaikan di beberapa bagian dan 

pengembangan sistem yang menyeluruh di semua lini 

sehingga nantinya akan didapatkan suatu aplikasi yang 
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benar-benar berrmutu dan berguna bagi pimpinan perguruan 

tinggi dalam membantu pengambilan keputusan dengan 

cepat dan tepat. 
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